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Introduction

Congratulations on purchasing Transverter Pro! A complete PostScript/PDF interpreter,
RIP, previewer, and conversion utility. Use it for the production of illustrated manuals,
service bureau PostScript/PDF conversion, illustration work, slide production, presenta-
tion, or anything else that requires a PostScript interpreter.

RIP!
* RIP PostScript Level 1-3, PDF & EPS files to TIFE, JPEG and GIF formats.
* RIP files for your large format output device or edit PostScript files in Photoshop.
* Reduce placed EPS image incompatibilities. RIP them, then place in Quark or Page-
Maker. No need to worry whether they will RIP in the final output!

Edit!
* Make an entire PostScript file visually editable. Used with FreeHand, Illustrator, or
Corel DRAW and Photoshop, Transverter Pro makes your PS, PDF and EPS files into
visually editable paths, text, and bitmaps.
* Quark and PageMaker users can take any working page, export it as an EPS file, and
make it editable.

Place!
* Get placeable PostScript! Convert PostScript into placeable EPS images.
* Attach previews to EPS files making them viewable in Quark, PageMaker, PowerPoint,
and Persuasion. No more gray boxes!

View!
* View EPS, multipage PS and PDF files on-screen. No need to print it to see what the
file contains.
* Web surfers can add reliable PostScript file viewing to World Wide Web Internet
Browsers like Netscape Navigator and Microsoft Internet Explorer.

Softproof and Preflight!

* Test PostScript files FAST before sending to your output device. RIP the file to your
screen and inspect it in a fraction of the time a printer can do it.

* [dentify missing or incorrect fonts, bad PostScript, and misplaced linked files.

* Visually verify file integrity, accuracy, and font availability.

* Zero in on warnings and errors using the built-in Status window. See on screen where
a PostScript page fails and quickly identify the problem area.
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What’s new in Transverter Pro 4.0?

Improvements & Changes

PostScript Level 3 Interpreter! - We have upgraded the Transverter Pro interpreter
to PostScript Level 3. This gives T-Pro the ability to handle the most current Postscript
features available.

Support for Acrobat 5.0! - Acrobat 5.0 produces a new PDF file format (version 1.4).
Transverter Pro now supports this new version of Adobe’s software.

Advanced Features

New! Hot Folders! - automate your workflow with Hot Folders that Transverter Pro
watches constantly for files to process. Access the hot folders over networks to help
expand your workflow automation.

You now can designate hot folders to several different file formats at one time.
This will expand your output delivery system.

Higher Resolution! - Rasterize files to as high as 10,000 dpi resolution

Input Files

¢ PDF (Adobe Acrobat)

* PostScript Level 3 (.ps)

* Print to Disk PostScript (.prn)
* Encapsulated PostScript (.eps)

Output Formats

Raster: ¢ TIFF  GIF « JPEG

Vector: * EPS ¢ Adobe Illustrator 1.1 » Adobe Illustrator 88 ¢ Adobe Illustrator 3.0
¢ PICT vector
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System Requirements

To use Transverter Pro you will need:

1. A G3 or G4 Power Macintosh

2. MacOS 10.1 or later - T-Pro will not run on Mac OS9 or earlier.

3. At least 300 megabytes of free hard disk space (for workspace purposes)

4. 128 megabytes of RAM (for minimum performance purposes)

5. The Helvetica font must be installed in your System Font folder.

This is the Default Font - see Troubleshooting: Font Substitutions for a full explana-
tion.

Transverter Pro Installation

The Transverter Pro CD contains the Transverter Pro installer file.
There are three basic components that are installed:
* Transverter Pro application, found in the Applications folder
* Supporting files and folders:
* Special font directory: Other Fonts
e Hot Folders default directories (4)
The supporting files and folders are located in:
~/Library/Application Support/Transverter Pro folder.

1. Insert the CD into your computer.

2. Open the T-Pro CD Icon on your desktop by double-clicking on it.

3. Locate the Transverter Pro installer Icon and double-click on it.

The installer will install the Transverter Pro application and all of it associated files.
During installation, you will be asked for your user password. This is for installing the
PACE InterLok® software components. Once you enter the password, the software will
be installed. Select Quit from the PACE dialog.

4. Restart your computer.

Registration and Activation

In order to use T-Pro, it will be necessary to Register and Activate the software.
Note: To activate your software, you must have access to an Internet connection and the

file MUST be generated on the computer you will run the software on.
Here is how to complete the process.
1. Double-click on the T-Pro application icon (found in your Applications folder).
The PACE activation window will appear with two options available,
Try and Authorize
2. Click the Authorize button.
3. Fill out the entire Registration information dialog and click the Continue button.
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4. Click the Save License Request button and save the Request file to your desktop.

5. In your browser, go to the Activation page: http://www.techpool.com/activation/
Here is where you will submit your License Request file.

6. Enter in the serial number (found either on your Transverter Pro CD or given to you

with your purchase), your E-mail address, and browse for the Request file. Once you

have completed this process, click the Upload button. We will automatically create the

needed Licence file and send it to your E-mail address (this usually only takes a mo-

ment).

7. Retrieve the License file from your E-mail.

8. Start T-Pro and click Authorize and go to the next screen. Click the Read License

button and locate the License file.

Or, Double-click on the file and Transverter Pro will automatically be activated.

Now you can run your copy of Transverter Pro
Note: Consider making a copy of the license file on a floppy or CD, in case you need to

reinstall T-Pro on this computer in the future.

Uninstalling Transverter Pro

To Uninstall T-Pro and it components, follow the steps below.

1. Go to User/Applications/Transverter Pro folder

2. Double-click the Inter Lok® Extensions Install application

3. Select Uninstall from the pop-down menu found in the upper left corner of
the dialog box.

4. Click the Uninstall button in the lower left corner of the dialog box.
This will remove the PACE Interl.ok® software from your computer.

5. Drag the Transverter Pro folder to the Trash and select Empty Trash from
the Finder menu.

Quick Start Examples

This section is designed to provide you with examples of how to use Transverter Pro in
your everyday operations. Hopefully, from these example sessions you will be able to
quickly learn how to use Transverter Pro and immediately begin using it in your everyday
operation. Following these sessions are more in depth explanations of Transverter Pro’s
features for use as a reference.

Session #1 — Viewing and Editing a PostScript file
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You were given an EPS image to use with a newsletter you are working on. You need
to place the image into Adobe PageMaker™, but only get a gray box. You need to be
able to see the image on-screen so you can format text around it.

First — Preflight On-Screen

The reason you only get a gray box when importing to PageMaker is because there
is no preview attached to the EPS or PS file or PageMaker cannot read the preview.
To attach a screen preview for PageMaker to use, launch Transverter Pro and select
Open... from the File menu. From the Open dialog box, double-click on the EPS im-
age. Transverter Pro will display the Viewing Options window. For descriptions of
the options on this window, refer to the Viewing a File section in this manual. Once
you have your viewing options set, click OK. Transverter Pro will rasterize the image
and display it (Figure 1).

806 Document.pdf <66.67%>
LN O et 2y o |

Lore Corperas nim volobore daolore.
seilue bl dlaur seulbis sugns nisloy

Figure 1 — Viewing the EPS file

Second — Prepare the File for Editing
When viewing the file, you notice that there are some changes needed in the image. You
decide you are going to need to edit the file with Macromedia FreeHand®. Transverter
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Pro can create a file editable in FreeHand. FreeHand can then import it. To create an
editable FreeHand file, which imports as an Adobe Illustrator file, select Export from
the File menu.

When the Export window is open, select the Adobe Illustrator 3.0 format from the
Format pop-up menu. Enter the file name me for the Export and click on Save.
Transverter Pro will next display the Illustrator 3.0 Options window. Change the op-
tions to your preferences and click on OK. For more information on these options, refer
the Output Format Options section. The file will be exported and saved as the name
you typed in.

Third - Edit the Image

Launch FreeHand, from the File menu choose Open...

Notice that there is a large difference between “placing” the Al file as an EPS file and
“opening.” When you place an EPS file into FreeHand, you are placing an uneditable
graphic. You will only have limited control over the image, for instance moving and
cropping. With the help of Transverter Pro, you have created a file that can actually be
edited by FreeHand.

When the image is opened, all paths will be grouped to form one large object. To
ungroup the paths for editing, click on the image, selecting it, and from the Arrange
menu choose Ungroup.

After editing the file, you can save it as an EPS file and place it into PageMaker using
Place under the File menu.

The result is a preview of your image on the PageMaker page instead of the gray box.
Now you can see exactly where the image is and can accurately wrap text around it.

Session #2 — RIP EPS files to TIFF

You have a large collection of EPS files that you need to editin a bitmap editing program,
such as Adobe Photoshop™. You need to quickly and precisely rasterize the EPS files
to a high resolution TIFF that can be imported into Photoshop.

Batch Converting to TIFF
Instead of opening each EPS file, viewing it, then exporting it, Transverter Pro allows
you to perform a batch conversion. A batch is a collection of files that are all to be
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processed the same way. In this case, our batch is the large collection of EPS files that
are all to be made into high resolution TIFFs.

To begin, launch Transverter Pro and select Batch Convert... from the File menu.
Transverter Pro will open the Batch window. From this window, you can add files to
the batch by clicking on Add and remove files from the batch by clicking on Remove.
You can also change the destination folder using the Folder... button. Finally, select
TIFE from the Output Format pop-up menu. If the original output format was not
TIFE, Transverter Pro will display the TIFF Options window. If TIFF was already
selected as the output format, click on the Options... button to get this window. You
can customize how your files are rasterized. For details about this window, refer to the
Output Format Options section. When you are satisfied with the TIFF options, click
on OK. Transverter Pro will return you to the Transverter Pro Batch window. If you
are ready, click on Start and Transverter Pro will begin rasterizing the files for you.
Depending upon the size and quantity of your files, the rasterizing will take varying
amounts of time.

When Transverter Pro is finished rasterizing the EPS files to TIFE, open them into Pho-
toshop. Launch Photoshop and select Open... from the File menu.

Locate one of the converted files in the open dialog box and double-click on it. Photo-
shop will open the file for editing.
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In this section is a more thorough explanation of Transverter Pro's features.

Status Window

The Status Window (Figure 2), is Transverter Pro’s means of communicating to you.
In it will appear font information and any PostScript errors as well as a listing of the
files processed.

&) Transverter Pro Status
Idle

Opening "sel.eps” for viewing... O

%[ SanbolkdT not found, uzing Helvetica 1%%
5[ Universal-MeveswithCommPi pot found, uzing Helvetica 15%%

Dore viewing "sel.eps”

Figure 2 — The Status Window

Viewing a PostScript, EPS, or PDF File

To view a file, from the File menu, select Open... Transverter Pro will display an open
dialog box; locate and double-click on the file you would like to open. As the file opens
itis checked to determine which file format it is, PostScript, EPS, or PDE. Depending
upon the format, different viewing options will be available.

Ignore DSC Comments

Document Structuring Conventions (DSC) Comments are information placed into a
PostScript file (they don’t occur in EPS or PDF files) to assist page management sys-
tems in working with a PS file. Occasionally Transverter Pro will get an error message
when viewing a PostScript file because of DSC Comments. If you are trying to view
a PS file but get an error try checking this box, located in the Open file dialog box and
then view the file. Frequently this solves the problem.

File Viewing Common Options

Rotation and Mirroring

Rotation and mirroring can also be changed when viewing. Rotations in increments
of 90 degrees are available under the Rotation pop-up menu and mirroring of None,
Vertical, Horizontal, or Both are available under the Mirroring pop-up menu.
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Resolution

From the Resolution pop-up menu, the resolution can be selected. Monitors typically
display at only 72 or 96 dots per inch (dpi), but if you intend to zoom into the image and
look at fine detail, you may need to use a higher resolution. On the pop-up menu are
some of the more common resolutions along with short descriptions of where they are
typically used. If the resolution you desire is not on the pop-up menu, select Custom
and enter your custom resolution in the text box below. The resolution you chose only
applies to viewing the file and not to exporting or converting.

Color Space

Finally, the Color Space pop-up menu allows you to select the type of color space you
would like. Available are Monochrome (1-bit), Grayscale (8-bit), RGB Palette Color
(8-bit), and RGB True Color (24-bit). CMYK is not available for viewing on-screen as
screens are only RGB. The color space you chose only applies to viewing the file and
not to exporting or converting.

PS Viewing Unique Options

If Transverter Pro determines that the file you are opening for viewing is a PostScript
file, it will display the PS Viewing Options window (Figure 3). From this window,
you can customize how the file is displayed on screen.

PS Viewing Options

Page Size: Letter (8.5 x 11 in)

by inches T’

Rotation:  Portrait (D7)

Mirroring:  None _:1

Resolution: " 72 DPI (Preview) H

DRl
Color Space: RGE Palette Color... 2|

“ Cancel } 0K

Figure 3 — PS Viewing Options Window
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Page Size

When opening a PostScript file, you must select the page size to use when displaying
the image. To do this, first choose the measurement scale you would like to use from
the upper right pop-up menu (displaying “points” in the figure). After selecting the
measurement scale, select a page size from the top pop-up menu. Popular page sizes
are available, but you can also enter a custom page size, or a page size noton the menu,
select custom from the Page Size pop-up menu and enter the desired dimensions in the
text boxes.

EPS Viewing Unique Options

If Transverter Pro determines that the file you are opening for viewing is an EPS file,
it will display the EPS Viewing Options window (Figure 4). From this window, you
can customize how the file is displayed on screen.

EPS Viewing Options

Page Size:

| |b‘f’| | points (s
|Ei Use EPS Bounds Instead OF Page Size

Rotation: | portrait (07 [

Mirraring: | Mane )

Resalution [ 72 DPI (Previewd P

Color Space: | RGETrus Color(24-bity | &)

Cancel f oK 3

Figure 4 — EPS Viewing Options Window

Use EPS Bounds As Page Size

EPS files contain a statement which defines the page size for the image. If this check
box is checked, this page size will be used and the dimensions will be displayed in gray
text in the page size text boxes. You can change the measurement scale used in these
dimensions with upper right pop-up menu (displaying “points” in the figure).

Page Size
If the Use EPS Bounds As Page Size check box is checked, the Page Size pop-up menu
will be grayed and the page size will be determined from the EPS file.
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If you would prefer to use a different page size than the one specified in the EPS file,
uncheck the Use EPS Bounds As Page Size. Next, select the page size you would
like from the Page Size pop-up menu. Popular page sizes are available, but you can
also enter a Custom page size, by selecting custom from the Page Size pop-up menu
and enter the desired dimensions in the text boxes. You can change the measurement
scale used in these dimensions with the upper right pop-up menu (displaying “points”
in the figure).

PDF Viewing Unique Options

If Transverter Pro determines that the file you are opening for viewing is a PDF file, it
will display the PDF Viewing Options window (Figure 5). From this window, you can
customize how the file is displayed on screen. Available options are as follows.

PDF Viewing Options

Rotation: | portrait (0% _:1

rirraring: | None =]

Resalution [ 72 O (Prewiew) ]

Colar Space: | RGETrue Color (2d4-bit) _:1
(Cancel ) 50K

Figure 5 — PDF Viewing Options Window

NOTE: Page size is not shown because the PDF file contains the page size already.
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Transverting a Single File

There are two ways to convert a single file. The first method is to start by viewing the
file, then select Export Page... or Export Selection... from the File menu. Transverter
Pro will prompt you for the output format. This method has the advantage of letting
you softproof the image before converting.

The second method is to treat the single file as a batch. Transverter Pro processes a
batch without rasterizing the file to the screen. This eliminates the overhead required
for viewing and allows your files to be converted more quickly. The disadvantage is
not being able to softproof the image. If you do not need to softproof the image, convert
the image by going to the File menu and selecting Batch Convert...

Batch convert files with Transverter Pro

Many times you will need to convert a large number of files all in the same manner. To
make this easier, Transverter Pro allows you to process files in “batches.”
When transverting a batch the same processing is done to all of the files.

To run a batch, select Batch Convert... from the File menu (Figure 6).

6 O Transverter Pro Batch

Output Fonmat: | TIFF =3 |

Letter Page Size (Or Input EPS Bouwnds If Soailable) -
Portrait Orientation. Mo Mirroring ODUOHS...

2540 DOPI. RGE. High Pyramid Antialiazing Se——

LZW Compression

Destination FalderHD Users TPro Desktop :T-Pro Output f Folder |

Filez In Batch:

" Add...

Figure 6 — Transverter Pro’s batch window
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Using the QOutput Format pop-up menu at the top of the window, select your output
format. Available are EPSE, TIFIF,Adobe Illustrator 3.0, 1.0, and 88, PICT Vector, JPEG
and GIF. After changing the output format or clicking the Options button, Transverter
Pro will display a window for choosing output format options. This window is specific
to the output format chosen.

These options are described in the Output Format Options section.

By clicking on the Folder button, you can select the destination folder for your converted
files. By default, Transverter Pro writes converted files into the folder T-Pro Output
on the Desktop.

Click on the Add button to add files to the batch to be transverted (Figure 7).

Add Selected Files

From: | @8 Desktop Bl

& ihg.rtf O
¥ 0uro0116_...__exile,jpeg

M Ourc0116_...y__exile.psd
03-10-02_TGS
0000074-chart EPS
216-789-3268.
1230.eps
® Al

Current List of Files. Add All

Add to Favorites Cancel

Figure 7 — Batch Add Window

The Batch Add Window contains two areas. The top scroll area is a list of files and
folders on your hard drive. All selections for files to be added occur in the top scroll
area. The bottom area contains a list of the files in the batch. To add a file to the batch,
go to the file in the top scroll area and double-click on it or click the Add button located
in the lower right corner. If you would like to add all the files in a folder, open the folder
in the top area, displaying all the file names in the top box, and click on Add All. You
may add any number of files from any number of folders. Finally, to remove a single file
from the list in the bottom box, select the file and click the Remove button; to remove
all files from the batch, click on Remove All button. When you have add all of the files
you would like in the batch, click Done. After you are satisfied with the contents of the
batch, click on Start to begin processing the files.
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Hot Folders

Hot Folders (aka, Watched Folders) allow the user to create specified Input format folders
that are monitored by T-Pro. When a file is added to the folder, T-Pro will automatically
convert the file to the selected output format, then move the file to the designated output
folder. If the encounters an error in the file, it will be moved to the Errors folder.

The user can create several folder sets for different file output formats.

Example: » Folder set for JPEG » Folder set for TIFF ¢ Folder set for EPSF

All of which are watched at the same time. The user then, can drag & drop or output files
into any one of the Input folders and have T-Pro convert the file to that folder's specified
file output format. This is a major feature in production environments.

Getting Started

We have provided a default folder set for you to start with.
These default folders are located in:

Home/Library/Application Support/Transverter Pro 4.0
A

|

Note: To get to this location, open a window and click on the Home icon [HomMe | at the
top of the window. This will open the Home folder. Then open the Library folder, then
the Application support folder, then the Transverter Pro 4.0 folder.

Hint: To ease the accessibility of these folders, drag the Transverter Pro 4.0 folder into
the right side of the Dock on your desktop. This will place an alias of the folder into the
Dock. Click on the folder to open. Make sure that you do not move the original Transverter
Pro folder outside of the Application Support folder.

Begin by selecting Hot Folders from the File menu.
The Hot Folders List will appear (Figure 8).

You will notice in the list is a folder named: Default Hot Folder. This is the default folder
set that we have provided to get you started. The output format for this folder is set to
TIFF format at 72dpi, 24-bit color. This means that any PDF, EPS or PS file that is added
to the Input folder will be rasterized (RIPped) to a 72dpi TIFF with 24-bit color.

Click on the name: Default Hot Folder and the Edit button will highlight
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Hot Folder List

Default Hot Folder

P .Y

( Add

o N

{ Edit )

’ Delete ‘

Fi

{ start )

F i »
[ Close }

Figure 8 - Hot Folder List

Clicking the Edit button will display the Hot Folder Options dialog (Figure 9).

Cutput Format: | TIFF

Letter Page Size (Or Input EPS Bounds I forailable)
Fortrait Orientation, No Mirroring

72 OPI. RGE. Mo Antialiasing

Mo Compression

( Options... )

- Folder Setup
ottt
[ Source.. }:

’ Destination...

Errors...

") Trash

. P .
IMowve source file to _ Deletion

Saved... + Driginals

% Mac OSK-G4:Usersicharlesngd:Desktop:Fipelines:TIFF In
% Mac 05K-Ca:Usersicharlesngd:Desktop:Pipelines:TIFF Out

%, Mac 03K-Ca:Users:charlesngs:Desktop:Fipelines:Errars

CNn SUCC2ss
¥ Saved folder
%, Mac 05%-G4:Users:charlesngsd:Desktop:Fipelines:Saved

' b Y
[ Cancel |

Figure 9 - Hot Folder Options dialog window

Here is where the format options, all folder locations and original file management

can be configured.
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The Hot Folder Options dialog overview:

Output Formats pop-down menu:
This is where the type of output formats are selected. Formats include: TIFE, EPSE,
JPEG, GIF, Illustrator 3.0, [llustrator 1.1, Illustrator 88 and PICT

Options button:
Edit the options available for the selected format by clicking this button.
Example: Resolution (dpi), Color space, Anti aliasing, Font embedding etc.

Format Feedback area:
This lists the currently selected options of the format. The information will change to
reflect any new adjustments made to the format options.

Folder Setup section:
Setup a folder set in this area by selecting a folder for each function.

Note: a Folder Set consists of an Input, Output, Errors and possibly an Originals fold-
ers for one format. However, you can use the same Errors and Originals folders for
different folder sets.

Source (default: Default Hot folder)

This is a Hot Folder (Input). Any file placed into this folder will be processed by how
you setup the output format (default is 72dpi TIFE files). You can Drag & Drop, Spool
or Copy a PostScript, EPS, or PDF file into it for processing.

The name of this folder will be displayed in the Hot Folder List window.
Make the folder name unique to the format and it's options.
Examples 360dpiRGBTIFE, EPSallfonts or JPEG etc.

Destination (default: T-Pro Output folder)
After T-Pro has successfully converted the file it writes the new file in this folder (default
72dpi TIFF files).

Errors (default: T-Pro Errors folder)

Files are moved from Source folder into the Error folder if they cause an interpreter
error while processing. Also, while processing a file pressing Command-Period will
immediately stop the Hot Folder feature and the file currently being processed to the
Error folder.



Using Transverter Pro

Saved (default: T-Pro Originals folder)

Source files can be moved here after processing you if have chosen Move source file
to Saved folder on success.

This allows you to reuse the original file again.

Other choices for Source file(s) disposition
Above we showed you how you can move your Source files to a Saved folder after
processing.

However, there are two other choices for post-processing Source file actions:
1. Move Source file to the Trash. Source files will automatically be moved to the
Trash. You must manually select Empty Trash to delete the files from your machine.

2. Move Source file to Deletion. Be careful with this option, this choice completely
deletes the Source file from your Macintosh. Be absolutely sure you (a) have a backup
copy of the original file or (b) are positive you will never ever need the Source file(s)
again after processing through Transverter Pro.

Creating new Hot Folder sets:

Here is explained how to create a new hot folder set for Transverter Pro to watch.

Start by creating 4 new folders in a desired location.
Example: Create 4 new folders on the desktop.

Again, the Hot Folder's name will be displayed in the Hot Folder List window.
Give the Hot folder (Input) folder a unique name that will reflect the type of format
options that will be attached to that folder.

Examples: TIFF360dpiRGB, EPSallfonts or JPEG etc.

Name the other folders according to their functions (Output, Errors and Originals).
Now, to add the new hot folder set, select Hot Folders from the File menu.

This will display the Hot Folder list window.

Click the ADD button to add a new hot folder set to the list - the hot folder setup dialog
will display for you.

Select a format from the Formats pop-down menu.
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Click the Options button to configure the desired output options.

Click the Source button to navigate to the location of the newly created folders, and
select the hot folder.

Click the Destination button and navigate to the newly created Output folder.
Click the Errors button and navigate to the newly created Errors folder.

Click the Saved button and navigate to the newly created Originals folder.
Note: you can also select Trash or Deletion on success in this section.

Now click the OK button and the newly created folder set will appear in the Hot Folder
List window.

Click the Start button to begin watching the Hot folders.

Drag and Drop a PDE, EPS or PS file into the hot folder and it will be converted to the
designated output format.

You can create as many folder sets as necessary. Even folders sets with the same format

types, but with different format options. All of the hot folders will be watched by T-Pro
at the same time.
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Drag and Drop Files

You can drop files onto the Transverter Pro icon. When a file is dropped onto it,
Transverter Pro will Open/View the file to the screen. This feature will assist with
quick file viewing.

Font Options

Transverter Pro allows you to customize which fonts are used when transverting your im-
ages. To view the Font Options select Font Options from the Edit menu (Figure 11).

Font Options

fwesterm Type 1 Posticript Fonts Syster TrueType Fonts

AlBowwsmabcript Od4b-08

Abcratch Q AmericanTypewriter O
AdobeSansiie AmericanTypewriter-Bold

Adobeberifdid £ AmericanTypewriter-Condensed -
AkzidenzGrotesk-Black v AmericanTypewriter-CondensedBold |
| Disable Al | Disable Al

Other D05 And Mac Fonts Font Substitutions

<< Default Substitution =» Helvetica

J.—J'-\dd %

“Cancel f ok

Figure 11— The Font Options Window

System Type 1 PostScript, System TrueType Fonts

The PostScript Type 1 fonts installed on your System are listed in the upper left scroll
box and in the upper right are the TrueType fonts. Both of these font types are stored in
your System folder, typically in the Fonts folder. These fonts are also the ones available
to your applications. If you would like to not use one of these fonts when transverting
images, highlight the font and click on the Disable button below the box in which the
font 1s located. To enable a disabled font, select the disabled font and click on Enable.
Finally, if you would like to disable all of one type of font, click on the Disable All
check box for that font type.

Other DOS and Mac Fonts
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You can make fonts, not installed on your System, available exclusively for Transverter
Pro. To add fonts here just copy the font files into the Transverter Pro “Other Fonts”
folder. Then start or restart Transverter Pro to make the fonts available. On startup the
fonts will be verified and added. Corrupt fonts will not be added.

When verifying, Transverter Pro looks to see if the font is a font suitcase, Mac Post-
Script Typel font, Mac TrueType font, or PC DOS format PostScript font (.pfb file
extension). If the font is none of these types, it will not be added.

To insure proper Transverter Pro font finding, some rules apply.
ATrueType (TT) font is only one file (versus PS fonts consisting of two files).
The Suitcase may contain multiple T'T fonts.

Type 1 PostScript font requires two files to work. The Screen Font file and the Printer
Font file. The Screen Font file is contained inside the PS Suitcase and the Printer Font
file must be contained in the folder the PS Suitcase sits in. Lack of one or both files
will cause the font to not be recognized or usable by any Mac application including
Transverter Pro.

Font Substitutions

In the bottom right-hand corner of the Font Options dialog box is the Font Substitution
List scroll box. When a font is used that Transverter Pro does not have access to, a sub-
stitution must be made. All text in a PostScript file is either printed with the proper font,
substituted with a Specific Font Substitution, or substituted with the Default Font.

A Specific Font Substitution is when one font is substituted for another font.
For example, you can set Helvetica to always substitute for the Arial font.

The Default Font is the font that is substituted for a font requested by a print job that
is (1) not on your System and (2) not in the Other DOS and Mac Fonts list and (3) does
not have a Specific Font Substitution. In other words, use of the Default Font occurs
when Transverter Pro cannot locate a font by any other means.

To create a Specific Font Substitution, click on the Add button below the Font Substi-
tution List scroll box and the Font Substitution dialog box appears. (Figure 12).
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Font Substitution
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Figure 12 — Adding a Font Substitution

In the Original Font text field, type the exact name of the font to have a substitution
occur. Itis very important to be sure the font name is spelled correctly, including any
spaces, capitalization, and punctuation. It may be easier to cut and paste the font name
from the Transverter Pro Status Window, if the file has already been run and the Default
Font was substituted as seen in the Status Window.

After entering the Original Font, select the substitution font from the Gets Substituted
With: list. This list combines all the fonts from the System Type 1, System TrueType,
and Other DOS and Mac Fonts lists. When you are finished, click on OK. Now the
new font substitution will be seen in the Font Substitution List.

To edit a Font Substitution, select one from the list and click on Edit. Note that you
can also select the <Default Substitution> at the top of the list and edit this font. After
clicking on the Edit button, the Font Substitution window will appear as before, but
with the Original Font text box filled in. You can now select a different substitution
font from the list or change the name of the original font. When you are finished, click
on OK and the changes will be seen in the Font Substitutions List.

To remove a substitution, select the font in the Font Substitutions List then click on the
Remove button.
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Viewing Window Button Bar

When viewing a file with Transverter Pro, a viewing window is created that contains
the image. At the top of the window is a button bar (Figure 13).

[N Q| vt 2 |

Figure 13 — Viewing Window Button Bar

The three left-most buttons will always be available and usable. The remaining five
are for handling multiple page files. If the file you are viewing does not have multiple
pages, these buttons will be shaded gray and unavailable. A description of each button
follows.

L

L

The Arrow Select tool is used to select an export region. By dragging the
arrow tool to form a box, you can select a portion of the file to export. Then, choose
Export Selection from the File menu to export.

22
N

The Hand tool is used to navigate through the page. You can move the
page by selecting a point and dragging the page.

-

o

The Zoom tool is used to zoom in and get a closer view of the image. After
selecting the tool by clicking on it, you can zoom into an area by clicking in the center
of it. You can also use the zoom tool to select a viewing region. Drag the tool to form
a box. Transverter Pro will zoom appropriately to fill the Viewing window with the
zoom selection. To zoom back out, hold down the Option key, changing the plus sign
to a minus sign, and click on the image.

it

Clicking on the First Page button puts you at the beginning of the file and
on the first page. This button will only be available if you are not on the first page and
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there are multiple pages.

1t

Clicking on the Previous Page button will move you to the previous page.
If you are on the first page or there is only one page, this button will be grayed and
unavailable.

Clicking on Goto Page button will allow you to enter a specific page to

&

change to.

1

Clicking on the Next Page button will advance you to the next page. If
you are on the last page or there is only one page, this button will be grayed and unavail-
able.

1

Clicking on the Last Page button advances you to the final page. If you
are already on the last page or there is only one page, this button will be grayed and
unavailable.
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There are a number of output format options, specific to each of the different formats
available. The options will appear in their own window when you either select a differ-
ent format or click on the Format Options... button when converting. Some options are
common to all file formats. These options are found in the Common Output  Options
section. Other options are common to all Raster (TIFF, GIF, and JPEG) formats and
are covered in the Raster Common Options section.

Common Output Options

These options work with every format output by Transverter Pro.

Rotation

Choose the rotation you would like via the Rotation pop-up menu (Figure 14). Available
are all 90 degree rotations.

< Portrait (0%
Landscape (907 cloclwise)
907 counterclochkwise
Upzide Dowen (1807

Figure 14 — Rotation Options
Mirroring
You can also specify how you would like the output mirrored via the Mirroring pop-up
menu (Figure 15). Available options are None, Vertical, Horizontal, or Both.

< Mone
Harizantal
Wertical
Both

Figure 15 — Mirroring Options

Raster Common Options

Page Size

If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
Instead, the Page Size will be the size you specified when you opened the file or if you
have selected a region, will be the size of the region. The Page Size dimensions will
be displayed at the top of the TIFEF Options window (Figure 16).
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TIFF Options

Image Size:

| | by | | inches ﬂ

Figure 16 — Page Size dimensions

Choose the measurement scale you would like to use from the upper right pop-up menu
(displaying “inches” in the figure). After selecting the measurement scale, selecta Page
Size from the Page Size pop-up menu (Figure 17). Popular page sizes are available, but
you can also enter a custom page size by selecting Custom from the Page Size pop-up
menu and entering the desired dimensions in the text boxes.

w0 Letter (8.5 x 11 in)
Legal (3.5 x 14 in}
Tabloid (11 = 17 ind
A (210 % 297 mmd
A3 (297 x 420 mm)
B3 (182 x 254 mm)
B4 (257 » 364 mm)
Custom

Figure 17 — Page Size Options

Resolution (dots per inch, dpi)

The resolution for the bitmapped image can be selected via the Resolution pop-up menu.
Some standard resolutions are available on the pop-up menu (Figure 18), but a custom
resolution can be entered by selecting Custom from the menu and entering your own
horizontal and vertical resolutions. The maximum resolution is 10,000 dpi.

72 0Pl [Previevd
144 OPI (Browse)
200 DP (Love Res Laser
360 0Pl (Mypical InkJeth

" BO0 OPl Medium Res Laser)
2032 » 96 OPI [Standard Fax)
203 x 192 OPI [Fine Fax)
70 OF
1200 DOPFI (5citex Line Art)
1270 DFI
1440 OFI [Epzon High Res)
2048 OP1 [5lide Maker)
2540 DPI (Imagesetter)
Custom

Figure 18 — Resolution Options
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For information on the Calculated option, see the Calculated Images section.

Raster Size (number of pixels)

The Raster Size pop-up menu (Figure 19) allows you to specify the number of pixels in
the horizontal and vertical dimensions to be used in the image. Custom dimensions can
also be used by selecting Custom and entering the horizontal and vertical dimensions.

Custom

Figure 19 — Raster Size Options

Calculated Images
A relationship exists between Page Size, Resolution, and Raster Size as shown by the
following formula.

Raster Size (horizontal and vertical pixels) = Page Size x Resolution (dpi)

Your goal: A specific Number of Pixels in an Area

For example, say you want to create an image that contains 640 horizontal and 480
vertical pixels in 57 horizontal x 3” vertical.

First select the Page Size you want. Next from the Raster Size option choose Custom
and enter the number of pixels you want in the horizontal and vertical directions (e.g.
640h x 480v pixels). Transverter Pro will now automatically calculate a Resolution
(128h x 160v dpi).

Your goal: A specific Density of Pixels (dpi) in an Area

For example, say you want a 4” horizontal x 6” vertical image at 720 dpi.

First select the Page Size you want. Next from the Resolution option choose Custom
and enter your desired dots per inch (e.g. 720 dpi). Transverter Pro will now automati-
cally calculate the Raster Size (2880h x 4320v pixels).

Color Space

The Color Space pop-up menu (Figure 20) allows you to select the type of coloring you
would like. Available are Monochrome (1-bit), Graytone (8-bit), RGB Palette Color
(8-bit), RGB True Color (24-bit), CMYK True Color (32-bit).
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Manochrome [1-hith
Graytone [3-bith
RGE Palette Colar (2-bith

< RGETrue Color (24-bith
CHYE True Calar [32-hbit)

Figure 20 — Color Space Options

Antialiasing

The Antialiasing pop-up menu (Figure 21) allows you to select the type of antialiasing.
There are two types of antialiasing, Pyramid and Box. Each of these types are available
at three levels, low, medium, and high. Antialiasing is supported for Graytone (8-bit),
RGB True Color (24-bit), and CMYK True Color (32-bit) and NOT supported for RGB
Palette Color (8-bit) or Monochrome (1-bit).

Pyramid - Lowe
Pyramid - Medium
Pyramid - High
Box - Laww

Box - Medium
Box - High

Figure 21 — Antialiasing Options

Note: There are general rules when using Antialiasing. Use Pyramid for text laden pages
and Box for graphic laden pages. We suggest you test the different antialiasing types to



see which works best for your situation.
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Raster Output Formats (TIFF, JPEG, GIF)

TIFF

This format supports the Raster Common Options discussed earlier in this section.

Compression

TIFF Options

Page Size: | Letter (8.5 x 11 in} _.1

by inches _:|

|21 Use EPS Bounds For Page Size If Possible

Ratation: | porrait (0% ]

Mirraring: | None |
Resolution " E00 DPI Medium Res Lazert | )
Raster Size: [ Calculated |8

Color Space: [ RGETrue Color(24-bity | 5]

Antialiasing: [ Mone 44

Compression | Nane =

“Cancel | f ok )

Figure 22 — TIFF Output Options

You can select the compression method you would like to use in creating the TIFF
file via the Compression pop-up menu (Figure 23). Before selecting a compression
method, be sure the application you are intending to import the image to supports that

compression method.

The compression methods available for all Color Spaces are None and LZW. The CCITT
Group3 and CCITT Group 4 compression methods are available only for Monochrome
(1-bit), as these are fax formats.

Some graphic file viewers read CCITT Group 3 encoding differently. Therefore
Transverter Pro has two versions available. If lines appear in your Group 3 viewer try
using the Group 3 - No EOL version. This No EOL (End-of-Line) version removes the
EOL at the end of each stripe of data.
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MNone

CCITT Croup 3
CCITT Group 3 - Mo EOL
CCITT Group ¢

Figure 23 — Compression Options

GIF

This format supports all of the Raster Output Format Common Options except An-
tialiasing and Color Space. The GIF format only supports the RGB Palette (8-bit)
Color Space. Antialiasing is not supported because Transverter Pro does not support
antialiasing in this color space. An additional option is the Interlace Bitmap check
box.

Interlacing

If this check box 1s checked, Transverter Pro will Interlace the GIE Otherwise it will
be non-interlaced. Interlacing permits faster previewing of Internet and Intranet based
images by displaying every other line first.

JPEG

This format supports all of the Raster Output Format Common Options but limits the
Color Space selection. Available are Graytone (8-bit), RGB True Color (24-bit), and
CMYK True Color (32-bit). In addition, the Q Factor used in the JPEG can be set.

Q Factor

This allows control over how much compression is used when creating the JPEG file.
The more compression used, the more image quality lost. One (1) is the default and
standard number used. The typical range of Q Factor compression numbers is between
0.1 and 100. The higher the number, the more compression, but also the more loss of
image quality.
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Vector Output Formats (EPSF & Al)
EPSF (Encapsulated PostScript)

EPSF Options

Fage Size: | mytoSize

| | o | |

’21 Uze EPS Bounds For Page Size If Passible

Rotation: | portrait (07

Mirraring: | Nape [
Font Al

m Uze Binary Data
™ Use Posticript Lewel 2

: Uze JPEC Compression

Preview Type: | pdac Color (PICT)

Preview Resolution: | 72 O [Low)

DFI

’21 Copy Original EFS When Possible

“Cancel | f 0K ')

Figure 24 —-EPSF Output Options (Batch & Hot Folders)

If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
The Page Size you specified when you opened the file or the region you have selected
with the Arrow Tool will be used instead.

Select a Page Size from the Page Size pop-up menu (Figure 25). Popular page sizes
are available, but you can also enter a custom page size, or a page size not on the

menu, by selecting Custom from the Page Size pop-up menu and entering the desired
dimensions in the text boxes.
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< Letter (8.5 2 11 ind
Legal (8.5 x 14 in)
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Figure 25 - Page Size Pop-up

Using AutoSize, Transverter Pro will calculate the smallest Page Size (Bounding Box)
that can surround all the objects within the input file.

Use EPS Bounds If Possible

If you are exporting a file you are viewing, this check box will not appear. If this
check box is checked and the file is an EPS file, the page size will be drawn from
Bounding Box comment found in the input file. In all other cases, the page size se-
lected with the Page Size pop-up menu will be used.

Font Embedding

Fonts may be embedded into the EPS file to ease font problems when printing. A
font that is already embedded into an input file (PS, EPS, or PDF) is maintained in
the output (EPSF) file. This feature adds fonts that are not already in the input file.

Example #1 - PDF to EPSF (all fonts already embedded)

An advertiser sends in an ad in the form of a PDF file to a newspaper for placement.
All the fonts used in the ad were embedded into the file by the advertiser. The news-
paper needs to convert the PDF into EPS for placement in the news pagination system.

Transverter Pro converting the PDF will maintain all the embedded fonts in the output
EPSF file.

Example #2 - PostScript to EPSF (no fonts embedded)

Afile created by printing PostScript to Disk from a Quark XPress project with two pages
in it needs to be made into two separate EPSF files. The original PostScript file has no
fonts embedded. Running through Transverter Pro from PS to EPSF will embed fonts,
provided that the fonts called for in the file are available on the machine Transverter
Pro is running on.
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Example #3 - EPSF to EPSF (some fonts embedded)

An EPSF file requiring 6 different fonts to print properly is made on a Macintosh and
4 of the 6 fonts are embedded into the EPSF file. The file is moved onto a Windows
machine, placed in PageMaker, and printed to the same printer as was the file when made
on the Mac. The EPSF file prints 4 fonts correctly but the other 2 typefaces look wrong
having either been substituted with Courier or not matching in their character width.

The solution is to run the file through Transverter Pro and embed fonts using the EPS
font embedding option to embed fonts. This provides font fidelity cross-platform. In
other words, moving files cross-platform can cause problems with the same fonts not
being available or with fonts having different character widths in their cross-platform
version, even when printing to the same printer. The font embedding option can al-
leviate this issue for you.

Use Binary Data
This option creates EPS files in binary rather than ASCII format. The benefit is that files
can be smaller and move more quickly over your network or the Internet. This works

well in Macintosh environments.

NOTE: A problem can occur if the EPSF, with Binary Data, is going to be used in the
Microsoft Windows network operating environment. Here PostScript printers working
from an NT Server spooler can crash the printer (spewing out pages with gibberish text
on them) or act like they will print then nothing appears out of the printer.

We suggest you NOT use the Binary Data feature when an EPSF file may need to be printed
on a PostScript printer under the control of a Windows environment.

Create PostScript Level 2
Level 2 PostScript brought many advantages over Level 1 including better color han-
dling. The default for this option is On.

Use Color Image Operator

PostScript Level 1 did not support a complete color model so an extension was added
to Level 1: Color Image Operators. Most Level 1 PostScript printers understand
these operators and the feature can be used. This option is grayed out unless “create
PostScript Level 27 is unchecked.

Use JPEG Compression

Provides JPEG image compression in PS Level 2 files. It will be grayed out if you
uncheck “Create PostScript Level 2. This feature compresses embedded images to
reduce file size.
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Preview
You can choose the type of preview you would like to attach to the EPSF file via the
Preview pop-up menu (Figure 26). Available options are None, Mac Color (PICT), Mac

B/W (PICT), DOS Color (TIFF), DOS B/W (TIFE).

NOTE: saving EPSF files with a DOS Color Preview makes them cross-platform compat-
ible. Macintosh Quark and PageMaker will accept them and display a color preview,
as well as their Microsoft Windows counterparts. Other products like FreeHand and
Microsoft Word can also take advantage of this feature.

Mane

« Mac Calor [FICT)
Plac BOW (PICT)
DO% Colar [TIFF)
oos BiW (TIFF)

Figure 26 - Preview Pop-down

Copy Original EPS When Possible

Check this box if all you want to do is quickly attach a Screen Preview to an EPS file.
If this box is checked your original file’s EPS code is used to create a Screen Preview.
The preview is then attached to the original file (Copy Original EPS). The When Pos-
sible means the option only works if the input file is an EPS. If itis a PostScript or PDF
file Transverter Pro must first create an EPS file then attach the preview.

NOTE: When Copy Original EPS When Possible is checked, T-Pro will NOT embed
fonts into the exported file. You must uncheck this option to embed fonts.
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Adobe lllustrator 3.0, 88, 1.1

These formats support text to outlines, filtering of vector data, bitmap images, text
and attaching previews.

Format Selection
Adobe Illustrator 3.0 - most draw programs on Macintosh and Windows support this
file format for editable import. It supports masks and compound objects.

FreeHand 5.0 and above will open Al 3.0 files for editing.

NOTE: This format does not support embedded bitmap images. Those images will
be exported as separate filename.img.eps files. Example; You have an EPS file that
contains Text, Vector and two bitmap images. When you export the file through AI3.0,
you will receive one AI3.0 file and two filname.img.eps files (filename.imgl.eps and
filename.img2.eps). If you keep all of these files together (in the same folder) when im-
porting into another program, the file will print correctly. The main AI3.0 file has pointers
that will place the bitmap images into the correct areas when printing.

Warning: Some files may contain hundreds of embedded bitmap files. T-Pro will create up
to 100 .img.eps files. The process will halt when the 100 file limit is reached.

Adobe [llustrator 88 - this format is maintained for backwards compatibility.
Adobe [llustrator 1.1 - no support for custom colors, compound objects, or masking.

Text To Outlines

Transverter Pro can also change the fonts contained in your image to text outlines.
If you would like this to always be done, select Always from the Text To Outlines
pop-up menu (Figure 27). If you would like outline fonts to never be created, select
Never. Finally, if you would like T-Pro to decide, choose When Appropriate.

« Mewer
When Appropriate
M

Figure 27 — Text To Outlines Options

Filters

You can select to filter objects from a PS or EPS file when transverting. If you would
like to filter ALL bitmaps, paths, or text from your image, select the appropriate
check box or boxes from the three Filter Out check box options.
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Preview
You can choose the type of preview you would like to attach to the Adobe Illustrator

file via the Preview pop-up menu (Figure 28). Available options are None, Mac Color
(PICT), Mac B/W (PICT), DOS Color (TIFF), DOS B/W (TIFF).

NOTE: saving Al files with a DOS Color Preview makes them cross-platform compatible.
Macintosh Quark and PageMaker will accept them and display a color preview, as well
as their Microsoft Windows counterparts.

PICT Vector

This format supports page size, text to outlines, and filtering of PostScript data.

Page Size

If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
The Page Size you specified when you opened the file or the region you have selected
with the Arrow Tool will be used instead.

Select a Page Size from the Page Size pop-up menu (Figure 19). Popular page sizes
are available, but you can also enter a custom page size, or a page size not on the
menu, by selecting Custom from the Page Size pop-up menu and entering the desired
dimensions in the text boxes.

Using Auto Transverter Pro will calculate the smallest Page Size (Bounding Box) that
can surround all the objects within the input file.

Use EPS Bounds If Possible

If you are exporting a file you are viewing, this check box will not appear. If this
check box is checked and the file is an EPS file, the page size will be drawn from
Bounding Box comment found in the input file. In all other cases, the page size se-
lected with the Page Size pop-up menu will be used.
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Text To Outlines

Transverter Pro can also change the fonts contained in your image to text outlines.
If you would like this to always be done, select Always from the Text To Outlines
pop-up menu (Figure 29). If you would like outline fonts to never be created, select
Never. Finally, if you would like Transverter Pro to decide, choose When Appropri-
ate.

Filters

You can select to filter objects from a PS or EPS file when transverting. If you would
like to filter ALL bitmaps, paths, or text from your image, select the appropriate check
box or boxes from the three Filter Out check box options.
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It is possible to create PostScript files for use with Transverter Pro in almost any appli-
cation and on any platform. There are two main ways to do this. The first is use your
application to “Export” or “Save As” to PostScript or EPS. The second is to “Print to
File” using a PostScript printer driver.

Export or Save As

In most popular applications, especially graphics applications, the option to Export or
Save As to a PostScript, EPS or PDF file is available.

If the Export option is available, select it. After selecting it, you should be prompted
for the type of Export you would like. Choose PostScript, EPS or PDF from these types
if  available. If neither of these choices are available read the next section “Print to
File.” Once you have chosen the file type, chose an appropriate name for the exported
file and any other options that are available. After this step is finished, you should have
a PostScript, EPS or PDF file which can be copied to your Macintosh via a LAN, CD
etc. and used with Transverter Pro.

Print to File

To Print to File, you are simply using a PostScript printer driver to send output to a file
instead of to a printer. This output is exactly what the printer would receive and is what
you will see when you use it with Transverter Pro. Below is described how to do this
in the Macintosh and Microsoft Windows. You may similarly create PostScript files in
any other operating system such as Unix, Linux, and OS/2.

Macintosh PostScript File Creation (Mac 0SX)

1. From the File menu, select Print.

The Print dialog will appear listing your printing options for that application.

Note: some applications have their own print dialogs, others use the system print options.
If the former is true, then select the Printer button to open the system print dialog.

From the drop down menu, select Output Options.

Check the Save as File checkbox

From the Format drop-down select PostScript (default is PDF)
Click the Save button at the bottom of the dialog box.

A Finder dialog will display.

Name the file and select a location to save it.

The driver will create the file and save it.

Nk L

~
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Microsoft Windows PostScript File Creation

Working in the Microsoft Windows environment you may need to create PostScript
files for Transverter Pro to work with. Making sure the proper fonts are available to
Transverter Pro when a file is interpreted requires a small amount of special planning,
This is especially true if moving files from one machine to another where installed fonts
may be different. All that is necessary is for you to install a printer that we have tested
extensively works with Transverter Pro for easy cross-machine and cross-platform font
handling. Please follow your specific platforms instructions for installing a printer
driver or making an EPS file.

An overview of creating PostScript files in a Microsoft Windows environment is to:

1. Install a Transverter Pro tested printer driver. Some tested drivers are available in
the Transverter Pro for Microsoft Windows manual at our web site. A driver that works
well is the QMS ColorScript.

2. Inthe application that you want to make a PostScript file from go to File : Print, then
select the printer listed above and print. Your application will write out a PostScript file
to disk (.prn or .ps file). Now use this file with Transverter Pro.

Extensive instructions for doing this are found in the Transverter Pro 4.0 for Windows
Users Guide. It 1s available, in Acrobat PDI format, at our website:
http://www.techpool.com.

Creating Encapsulated PostScript (EPS) Files

EPS files can be made directly in many applications.

For instance:
Quark - File : Save Page As EPS...
InDesign - File : Export - Format : EPS
[lustrator - File : Save As... then save in EPS format
FreeHand - File : Export... make the format EPS
Corel DRAW - File : Export
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PostScript®

PostScript (PS) is a sophisticated graphics programming language created by Adobe
Systems. It provides a very flexible way for computer application programs to present
a page description to an output device. For example, when a user prints to a PS laser
printer the computer sends PostScript code to the PS interpreter contained in the printer.
The PS interpreter does all of the work necessary to draw the described page.

To draw the page described in the PostScript description, the PS interpreter must translate
the PostScript into a collection of dots, much like a bitmap. These dots will then be
used for printing the actual output. This process of producing bitmap data from vector
and image data is called rasterizing. Rasterizing can be performed by hardware, such
as a laser printer which contains a PS interpreter, or by software such as the Transverter
Level 3 PS interpreter.

Programs that are able to create PostScript for printing typically do not use PostScript
for editing and displaying. They will use their own image format which is easier to
manipulate when editing then translate to PostScript when printing. This translation is
most commonly done by a PostScript printer driver instead of the program itself.

EPS (Encapsulated PostScript)

Encapsulated PostScript (EPS) is an extension of PostScript that was created to allow
applications to "place" a PostScript image on a page. Placing is used to incorporate a
smaller image into a document. EPS provides the information applications need to be
able to place and print an Encapsulated PS file.

Transverter supports EPS files, which are single page documents. These filesare typi-
cally created by designers, illustrators and ad agencies.

Adobe® Acrobate (PDF) Files

PDF (Portable Document Format) is becoming a universally accepted file format for
sharing documents on the Internet and on company Intranets. Itis a rich format capable
of containing text, fonts, images, and graphics that can easily be moved anywhere
electronically. Originally a superset of the Adobe Illustrator format it has grown into a
widely used file format. PDF files can be viewed and printed on many different operat-
ing systems using Abobe's Acrobat® Reader® software.




Troubleshooting

Transverter Pro is designed to provide trouble free operation. However, should you
experience any difficulty in its operation, this section will assist you in determining the
problem source and give suggestions to fix it.

Not all applications produce clean print files. If an application has made a PostScript,
EPS or PDF file improperly, Transverter Pro may produce incorrect output or report an
error in the Status window.

The diagnosis and correction of most PostScript errors goes beyond the scope of this
Users Guide. However, there are a few common problems this chapter discusses to
remove a little of the PostScript mystique.

RAM Memory Issues

Transverter Pro should be run smoothly on a machine with at least 128 megabytes of
RAM. With the new Macintosh OSX operating system, the Mac no longer needs memory
allocated to the application by the user. The System will automatically give T-Pro the
memory it requires to operate.

The interpreter engine will use as much RAM as needed and processing will be faster
with more RAM, within limits.

Machines that have small amounts of physical RAM and/or other applications running
while Transverter Pro is printing may find that jobs progresses slowly. If this is the
case, then Quit all non-essential running applications.

Disk Space Issues

This issue is not as common as it once was, due to newer larger hard drives.
This is an issue when outputting high resolution raster files (TTFF, JPEG, etc.) and when
making PostScript files printed to disk.

When you are working from an application program, like PageMaker, and then want to
make a PostScript output file you select “Print PostScript to File” in the printer dialog
box options area. This causes a print file to spool out to your hard drive. In some cases
it can require more hard drive space then you have remaining. If you are working with
large complex documents these spooled files can grow to very large sizes when you
Print to File.
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For example, say you are working with a PageMaker document which has a single placed
photograph (300dpi RGB). The photograph alone is 25 megabytes of data and at least
this much free disk space is required to print. Now imagine that you have a document
with 5 placed RGB photographs. The minimum total spooled file size will be 125
megabytes requiring this much free disk space before you start the print job.

The bottom line here is to keep an eye on available hard drive space and not underes-
timate how much you need.

Font Substitutions

When using Transverter Pro, messages communicate to you in the PostScript Messages
window about what fonts are being asked for by a file and, if the font is not available,
what font is substituted because of the font non-availability.

The example PostScript Message line below shows a file requesting the Helvetica font,
not finding it, and substituting ArialMT.

%%[ Finding Arial 1%%

%%[ Substituting Arial with Helvetica ]1%%

Transverter Pro uses Helvetica as its “Default Font.” This is the font the interpreter
will substitute when a specific font is not found. You can change the Default Font in
the Font Options dialog.

PostScript Errors

The Status Window will provide you with information about print processing. From
time to time it may display an error message (in red) which stops print processing.

An error message might look like this:

%%[ Error: interrupt; Offending Command: (- @interrupt -]%%
%%[Flushing:rest of job(to-end-of-file)will be ignored ]1%%

There are two important pieces of information from Line 1 to write down here:
1. the Error: interrupt

2. the Offending Command: @interrupt

At this point our Technical Support staff can be contacted for assistance.



Troubleshooting

FAQ’s (Frequently Asked Questions)

Question
I do not have an internet connection on the computer that is running T-Pro, so how can
I activate the software?

Answer: Generate the Registration file (TransverterPro.ilr) on the computer that you
are going to use the software on and move it to a computer with an Internet connection.
Complete the on-line activation, then move the returned License file (TransverterPro.ilf)
to the machine and double-click on the file.

Question
When I try to export an opened file, the Export menu is grayed out.

Answer: This is caused by opening a Non-DSC PostScript file. Non-DSC (Document
Structuring Conventions) is a set of instructions that Adobe wrote to maintain consistent
PostScript language between drivers and platforms. T-Proisa DSC compliant interpreter.
T-Pro does not understand where the end of the pages are (do to this problem).

To convert a non-dsc Postscript file, Add the file to the Batch Convert section. Then
batch convert the file. T-Pro will ignore the non-dsc comments and convert the file.

Question

I receive an error message when trying to convert a larger or more complex file.
%%[Error: VMerror; OffendingCommand:--@image--]%%
%%[Flushing: rest of job (to end-of-file) will be ignored]%%

Answer: Transverter Pro may require more hard drive space to process your job, see
Disk Space Issues earlier in this chapter. It could also be that Transverter Pro requires
more RAM to process the file. You may need to increase the amount of RAM installed
on your computer.

Question
Transverter Pro stops processing my file and produces many error messages in the
status window.

Answer: Be sure that the file you are processing is indeed a PS, EPS, or PDF file. These
files typically have a .ps,.pin, .eps, or .pdf at the end of the name. You can also check
the content of the file by opening it in a text editor or word processor. If the file is a PS
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or EPS file, it should begin with “%!PS-Adobe” and be all text characters. If the file
is a PDF file, it should begin with “%PDFE” and be mixed text and binary data. If your
file is not of one of these types, it is not supported by Transverter Pro.

Question
When viewing my file with Transverter Pro, my text does not look as it did when I cre-
ated the file and Transverter Pro reports in the status window that a font substitution
was needed.

Answer: When the file was created a font was used that was not embedded (included)
in the file. Without this embedded font, Transverter Pro must use the System installed
fonts. If the font can not be found on the System, a font substitution must be made.
Transverter Pro by default substitutes Helvetica, but you can customize font substitution
in the Font Options window. Refer to the Font Options window section for details.

Question
Is it possible to change the default Halftone settings to match my output needs?

Answer: Yes, you need to review the document named: Halffone feature T-Pro OSX
that in the Transverter Pro folder. This document will give you detailed instructions on
how to adjust the halftone setting within Transverter Pro's interpreter.

Question
How can I make my EPS files move cross-platform?

Answer: Use Transverter Pro to make EPS files with a DOS TIFE Preview. These files
are now supported by both Macintosh and Windows page layout programs so you can
share the files.

Question
I am trying to preview a PostScript file but I encounter an error?

Answer: Some PostScript files contain DSC Comments that cause problems with viewing
and/or converting files. After selecting File then Open check the Ignore DSC Comments
box then select your file to view. This frequently solves the problem.

Also See DSC comments question at the top of the FAQ section.
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Defective CD Replacement

TechPool Software will replace defective or damaged CD free of charge during the
90-day limited warranty period. After that period, damaged CD will be replaced for
a $20.00 charge per CD plus shipping and handling. Contact the Technical Support
department for an RMA number.

TechPool Software will not be responsible for CD lost or damaged in transit. If you have
not sent your registration card, you MUST send it with the defective CD.

Please send the defective or damaged CD with, if necessary, check, money order, or
credit card information.

Contacting Technical Support

TechPool Software has a qualified Technical Support staff ready to help you with your
problems when using Transverter Pro. Please make sure the problem you are having is
with Transverter Pro and not with your application software or System fonts.

Free Technical Support is provided
for 90 days from your first contact with Technical Support.
Thereafter Technical Support contracts may be purchased on an annual basis.
Contact our Customer Service to inquire about Support Contracts.

If you require technical support we can be reached via any of the following methods:

Mail......................... TechPool Software 2726 Loker Avenue West
Carlsbad, CA 92008
Telephone ............. (216) 382-1787
6:00 a.m. - 5:30 p.m. (U.S. Pacific Time)
Fax ... (760) 438-0343
E-mail .................. support@techpool.com
Web site: ................. www.techpool.com

When contacting us always provide the following information: Your name, company’s
name, address, daytime telephone number, E-mail address, fax number if available, the
type of system you are using, the application and version number, and a short but precise
description of the problem including errors reported in the PostScript Messages.



Legalese - software license

SOFTWARE LICENSE AGREEMENT FOR TECHPOOL SOFTWARE

The computer program(s) ( SOFTWARE) that came with this Users Guide is licensed to you by
TechPool Corporation ( TechPool) for use only under the terms of this License, and TechPool reserves
all rights not expressly granted to you. The SOFTWARE is protected by copyright laws as well as
other intellectual property laws.

1. GRANT OF LICENSE

This License allows you to:

(a) Use one copy of the SOFTWARE on a single computer at a time. To use the SOFTWARE
means that the SOFTWARE is either loaded in the temporary memory (i.e., RAM) of a computer or
installed on the permanent memory of a computer (i.e., hard disk, etc.). You may also store a copy
of the SOFTWARE on a common storage device, such as a network server, for use only to install
the SOFTWARE on your other computers over an internal network; however, you must acquire and
dedicate a license for each separate computer on which the SOFTWARE is installed and run on. A
license for the SOFTWARE may not be shared or used concurrently on different computers.

(b) Make one copy of the SOFTWARE in machine readable form solely for backup purposes. As an
express condition of this license, you must reproduce on each copy any copyright notice or propri-
etary notice that is on the original supplied by TechPool. No other copies are permitted. You shall
agree not to copy the documentation that accompanied the SOFTWARE.

2. RESTRICTIONS

The SOFTWARE contains trade secrets and copyrighted materials. You may not REVERSE EN-
GINEER, DECOMPILE, DISASSEMBLE OR OTHERWISE REDUCETHE SOFTWARETO ANY
HUMAN PERCEIVABLE FORM. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT,
LEASE, LOAN OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY
PART THEREOF. Except as stated herein, this License does not grant you any rights to patents,
copyrights, trade marks, trade names, (whether registered or unregistered) or any other rights, or
licenses in respect to the SOFTWARE and its documentation.

3. TERMINATION

This License is effective until terminated. This License will be terminated immediately without
notice from TechPool or judicial resolution if you fail to comply with any provision of this License.
Upon such termination you must destroy the SOFTWARE, all accompanying written materials and
all copies thereof, and Sections 4, 5 and 6 will survive any termination.

4. COPYRIGHT

All title and copyrights in and to the SOFTWARE (including but not limited to any images, photo-
graphs, animations, or text incorporated into the SOFTWARE) the accompanying printed materials
and any copies of the SOFTWARE product are owned by TechPool or its suppliers, with all rights
reserved.
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5. LIMITED WARRANTY

TechPool warrants for a period of ninety (90) days, from the original date of purchase, that (i) the
media (magnetic disk or CD) on which the SOFTWARE resides will be free from defects in mate-
rials and workmanship under normal use, and (i1) the SOFTWARE as provided by TechPool will
substantially conform to TechPool’s published specification for the SOFTWARE. TechPool's entire
liability and your exclusive remedy for any breach of the foregoing limited warranty will be, at

TechPool’s option, replacement of the media, refund of the purchase price or repair or replacement
of the SOFTWARE.

NO OTHER WARRANTIES.

THIS LIMITED WARRANTY IS THE ONLY WARRANTY PROVIDE BY TECHPOOL AND
TECHPOOL AND ITS LICENSORS EXPRESSLY DISCLAIM ALL OTHER WARRANTIES, EI-
THER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE WITH REGARD
TO THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS. BECAUSE SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF IMPLIED WAR-
RANTIES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

INNO EVENT WILL TECHPOOL, ITS PARENT OR SUBSIDIARIES OR ANY OF THE LICEN-
SORS, DIRECTORS, OFFICERS, EMPLOYEES OR AFFILIATES OF ANY OF THE FOREGOING
BELIABLETOYOU FOR ANY CONSEQUENTIAL DAMAGES, INCIDENTAL, INDIRECT OR
SPECIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMA -
TION AND THE LIKE), WHETHER FORESEEABLE OR UNFORESEEABLE, ARISING OUT
OF THE USE OF OR INABILITY TO USE THE SOFTWARE OR ACCOMPANYING WRITTEN
MATERIALS, REGARDLESS OF THE BASIS OF THE CLAIM AND EVEN IF TECHPOOL OR
A TECHPOOL REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

6. GENERAL - This License is governed by the laws of the State of California. If any provision of
this License shall be held by a court of competent jurisdiction to be contrary to law, that provision
will be enforced to the maximum extent permissible, and the remaining provisions of this License
will remain in full force and effect. If you are a U.S. Government user than the SOFTWARE and
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the
Government is subject to restrictions as set forth in subparagraph (c)(1)(i1) of the Rights in Technical
Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the
Commercial Computer Software-Restricted Rights clause at 48CFR 52.227-19, as applicable.
Manufacturer: TechPool Software, A Vivid Image Technology Company, 2726 Loker Avenue West,
Carlsbad, CA 92008.
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Bitmap Image

A bitmap image is stored as a collection of pixels. A pixel represents one dot on your
screen or printer. A simple way to think of a bitmap image is by putting a picture on
a fine grid. Each square of the grid that is covered by the picture is one pixel and is
represented individually in the graphics file. The pixel will be represented not only by
its location in the grid, but also by its color.

Embedded Font

An embedded font is a font that has been placed inside a document file. Typically, em-
bedded fonts are added to files by the program that originally created the file to ensure
the output device will have the font available to recreate the text contained in the file.
If the font was not available, another font would have to be used instead, yielding text
that is different than was originally intended.

Encapsulated PostScript (EPS)

EPS is a PostScript file that is limited to one page. It is “encapsulated” so the file or
image can be placed into other documents. It can also contain a PICT Preview in the
Resource Fork or a TIFF Preview in the Data Fork that will appear on-screen

Halftone
Halftone refers to how a computer image is printed by using a halftone cell. Cell size is
related to the screen density (or lines per inch) and determines how dithering is done.

Hot Folders
Hot folders are watched folders by an application. When a file is added to the hot folder,
the application automatically performs a task to that file.

Ipi (lines per inch)
Ipi relates to halftoning and number of colors. The more Ipi the finer looking the dither
but the less colors.

PDF File Format (Adobe Portable Document Format)

PDF is an application independent file that contains all the elements created by the
original application. PDF files can be opened, moved and printed cross-platform (Ma-
cintosh, Unix & Windows).
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PICT file format
A PICT file is the standard Macintosh graphics file format used in hundreds of applica-

tions. A PICT file can contain bit-mapped and vector graphics in one file.

PostScript (PS) file format
PostScript is a graphic programming language developed by Adobe Systems. PostScript

contains text, graphics, and image data and is device independent.

PostScript (PS) Interpreter
A PostScript interpreter is any device or program that is able to understand and use the
PostScript language. Most PostScript interpreters are used to produce printed output.

Preflight

To interpret and preview a PostScript file before sending it to an output device to insure
its’ reliability.

Preview

A preview is a special bitmap that is encapsulated, or contained, in an EPS file. The
preview is meant to be a rough snapshot of what the entire image looks like. It is
intended to provide applications with a means to display the contents of an EPS file
without actually interpreting it.

Printer Driver
A Printer Driver is a program that is used to convert application data to printer data that
the printer understands.

Softproof

Viewing a PostScript or PDF file after interpreting to insure it runs.

Spooling
A Printer Driver temporarily stores (spools) data onto a hard drive so that a printer or
application can then read it.
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